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SSLC IT EXAMINATION - MARCH 2025
PRACTICAL EXAMINATION - SAMPLE QUESTIONS

(Tamil Medium)
1. மாதிரியில் உள்ளது போல்  Inkscape மென்பொருளில் ஒரு பேட்ஜ் 
படத்தைத் தயாரிக்கவும்.

குறிப்பு:
• மாதிரியில் உள்ளது போல் Home இல் 

10Images  கோப்புதொகுப்பில் 
_1.  pic jpeg படத்தைச் சேர்க்கவும்.

• முழு படத்தையும் குரூப் செய்யவும்.

இந்தப் படத்தை svg வடிவில்   Home இல் 10 Exam கோப்புதொகுப்பில் 
உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து சேவ் 
செய்யவும்.

2. மாதிரியில் உள்ளது போல்  Inkscape மென்பொருளில் ஒரு படத்தைத் 
தயாரிக்கவும்.

இந்தப் படத்தை svg வடிவில் Home  இல் 10 Exam கோப்புதொகுப்பில் 
உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து சேவ் 
செய்யவும்.
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3.  மாதிரியில் உள்ளது போல்  Inkscape மென்பொருளில் ஒரு படத்தைத்
தயாரிக்கவும்.

இந்தப் படத்தை  svg வடிவில்   Home இல் 10 Exam கோப்புதொகுப்பில் 
உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து சேவ் 
செய்யவும்.

4. Home இல் _Exam documents இல் _QGIS Projects கோப்புதொகுப்பில் 
.WardMap qgs என்ற பெயரில் நிலப்படம் கொடுக்கப்பட்டுள்ளது.  QGIS

 Desktop மென்பொருளில் இந்தக் கோப்பைத் திறந்து கீழே 
கொடுக்கப்பட்டுள்ள செயல்பாடுகளைச் செய்யவும்.

• நிலப்படத்தில் , Ground MainRoad லெயர்களை காட்சிப்படுத்தவும்.
• River என்ற புதிய லெயரை உருவாக்கவும். (  :Layer Type  Line, 

:Attributes  ,  )Name Length

• இந்த லெயரைத் தேர்ந்தெடுத்து, நிலப்படத்தில்   5 Ward லிருந்து 
தொடங்கி  6 Ward வழியாக செல்லும் நதியை 
அடையாளப்படுத்தவும்.

           (  - 1,  –  ,  – 45  )Id Name Poorappuzha Length KM

இந்த நிலப்படத்தை  Save As  நுட்பம் பயன்படுத்தி உங்கள் பதிவு 
எண்_கேள்வி எண்ணைக் கோப்புப்பெயராகக் கொடுத்து,  Home இல் 

10Exam  கோப்புதொகுப்பில் சேமிக்கவும்.
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5.  Home இல் _  Exam documents இல் _  QGIS Projects கோப்புதொகுப்பில் 
.WardMap qgs என்ற பெயரில் நிலப்படம் கொடுக்கப்பட்டுள்ளது.  QGIS

 Desktop மென்பொருளில் இந்தக் கோப்பைத் திறந்து கீழே 
கொடுக்கப்பட்டுள்ள செயல்பாடுகளைச் செய்யவும்.

• நிலப்படத்தில் MainRoad யை காட்சிப்படுத்தவும்.
• MainRoad ற்கு சிவப்பு நிறம் கொடுக்கவும்.
• நிலப்படத்தின் Anganwadi லெயரில்  Attribute table  

காட்சிப்படுத்தவும்.
• இந்தச் சாளரத்தைக் கொண்ட  QGIS மென்பொருளின் 

ஸ்கிரீன்ஷாட்டை எடுக்கவும்.
ஸ்கிரீன்ஷாட் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து, 
Home இல் 10Exam  கோப்புதொகுப்பில் சேமிக்கவும்.   
(ஸ்கிரீன்ஷாட்டை எடுக்க கீபோர்டில்  Print Screen கீயைப் பயன்படுத்தவும்.
ஸ்கிரீன்ஷாட் கோப்பு Home இல்  Pictures கோப்புதொகுப்பிலிருந்து 
நகலெடுத்து, 10Exam  கோப்புதொகுப்பில் பெஸ்ட் செய்யவும். குறிப்பிட்ட 
முறையில்  Rename செய்யவும்.)

6. Home இல் _Exam documents இல் _  QGIS Projects கோப்புதொகுப்பில் 
.WardMap qgs என்ற பெயரில் நிலப்படம் கொடுக்கப்பட்டுள்ளது.  QGIS

 Desktop மென்பொருளில் இந்தக் கோப்பைத் திறந்து கீழே 
கொடுக்கப்பட்டுள்ள செயல்பாடுகளைச் செய்யவும்.
• நிலப்படத்தில்  Main Road லெயரைக் காட்சிப்படுத்தவும்.
• Anganwadi லெயரை நிலப்படத்தில் மறையச் செய்யவும்.
•  7 Ward க்கு கொடுக்கப்பட்டுள்ள பச்சை நிறத்தை மாற்றி சிவப்பு 

நிறம் கொடுக்கவும். 
இந்த நிலப்படத்தை ஒரு படக்கோப்பாக உங்கள் பதிவு எண்_கேள்வி 
எண்ணைக் கோப்புப்பெயராகக் கொடுத்து,  Home இல் 10Exam  
கோப்புதொகுப்பில் சேமிக்கவும்.
குறிப்பு:
படக் கோப்பாகச் சேமிக்க,  QGIS மென்பொருளில்     Project → Save as

Image நுட்பத்தை பயன்படுத்தவும்.
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7.  Sunclock மென்பொருளைத் திறந்து பின்வரும் செயல்பாடுகளைச் 
செய்யவும். 
• சன்கிளாகில் காலமண்டல 

வரைபடத்தைக் காட்சிப்படுத்தவும்.
• தீர்க்கக் கோடுகள், முக்கிய அட்ச 

கோடுகளை காட்சிப்படுத்தவும்.
• புது டெல்லியில் கால நேரத்தைக் 

காட்சிப்படுத்தவும்.
• இரவு பகல் என்ற வேறுபாட்டை 

முற்றிலும் தவிர்க்கவும்.
• இதன் ஸ்கிரீன் ஷாட்டை எடுத்து, உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு

பெயராக கொடுத்து Home இல் 10Exam  கோப்புதொகுப்பில் சேமிக்கவும்.   
    

(ஸ்கிரீன்ஷாட்டை எடுக்க கீபோர்டில்   Print Screen கீயைப் பயன்படுத்தவும். 
ஸ்கிரீன்ஷாட் கோப்பு  Home இல்  Pictures கோப்புதொகுப்பிலிருந்து நகலெடுத்து, 
Home இல் 10Exam  கோப்புதொகுப்பில் பெஸ்ட் செய்யவும். குறிப்பிட்ட முறையில் 

 Rename செய்யவும்.)

8. சன் கிளாக் மென்பொருளின் உதவியுடன் 2025 மார்ச் 21 அன்று (சம இரவு 
பகல்) சென்னை நகரில் (Madras) நண்பகல் 12 மணிக்கு சூரியனின் 
நிலையைக் காட்சிப்படுத்தவும். இதன் ஸ்கிரீன் ஷாட்டை எடுத்து, உங்கள் பதிவு 
எண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து  Home இல் 10 Exam

கோப்புதொகுப்பில் சேமிக்கவும். 
குறிப்பு:
• சன்கிளாகில் காலமண்டல வரைபடத்தைக் 

காட்சிப்படுத்தி  Madras செலக்ட் செய்யவும்.
• புரோகிரஸ் மதிப்பை மாற்றி
பரிந்துரைக்கப்பட்ட தேதி, நேரத்தை
சரிசெய்யவும்.
• வரைபடத்தில் சூரியனைக்
காட்சிப்படுத்தவும்.
• இந்த காட்சி உட்பட்ட சன் கிளாக் சாளரத்தின் ஸ்கிரீன்ஷாட்டை 
எடுக்கவும்.

(ஸ்கிரீன்ஷாட்டை எடுக்க கீபோர்டில்   Print Screen கீயைப் பயன்படுத்தவும். 
ஸ்கிரீன்ஷாட் கோப்பு  Home இல் Pictures கோப்புதொகுப்பிலிருந்து நகலெடுத்து, 

 Home இல் 10 Exam கோப்புதொகுப்பில் பெஸ்ட் செய்யவும். குறிப்பிட்ட முறையில் 
 Rename செய்யவும்.)
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9. Home இல் _Exam documents இல் _ .  Carnatic music ott கோப்பில் 
கர்நாடக இசை பற்றிய கட்டுரை கொடுக்கப்பட்டுள்ளது. இதை  LibreOffice

 Writer இல் திறந்து கீழே உள்ள வழிமுறைகளின்படி தலைப்புகளுக்கு Style

கொடுக்கவும்.
•   Carnatic music என்ற தலைப்புக்கு  1Heading  என்ற  Style

கொடுக்கவும்.
•  Heading பிரிவில்,  2 Heading இல் Music என்ற புதிய Style யை 

உருவாக்கவும். பின்னர்  Music என்ற  Style லில் பின்வரும் 
மாற்றங்களைச் செய்யவும்.

 Font Family :   Century Schoolbook L

 Font Size : 100 %
 Font Color :   1Dark purple

• கட்டுரையில் உள்ள அனைத்து துணைத் தலைப்புகளுக்கும் இந்த 
ஸ்டைலைக் கொடுக்கவும். (துணைத் தலைப்புக்கள் சிவப்பு நிறத்தில் 
கொடுக்கப்பட்டுள்ளது)
மாற்றியமைக்கப்பட்ட கோப்பை Home இல் 10Exam  கோப்புதொகுப்பில் 
உங்கள் பதிவு எண்_கேள்வி எண் கோப்புப் பெயராக கொடுத்து 
சேமிக்கவும்.

10. Home இல் _Exam documents இல் _ .Kerala art ott கோப்பில் 
கேரளாவின் கலை வடிவங்கள் பற்றிய கட்டுரை கொடுக்கப்பட்டுள்ளது. 
இந்தக் கோப்பை லிப்ரே ஆபீஸ் ரைட்டரில் திறந்து, துணை 
தலைப்புகளுக்கு பின்வரும் விவரக்குறிப்புகளுடன் Artform என்ற புதிய 
தலைப்பு ஸ்டைலை உருவாக்கவும்.

 Heading பிரிவின்  1Heading  என்ற புதிய ஸ்டைலை உருவாக்கவும். 
 Font family : Verdana

Style : Bold

 Font size : 22 pt

 Font color : Green

கட்டுரையில் உள்ள அனைத்து துணைத் தலைப்புகளுக்கும் Artform 
என்ற ஸ்டைலைக் கொடுக்கவும். (துணைத் தலைப்புகளுக்கும் 
எண்வரிசை கொடுக்கப்பட்டுள்ளது)
மாற்றியமைக்கப்பட்ட கோப்பை  Home இல் 10 Exam கோப்புதொகுப்பில் 
உங்கள் பதிவு எண்_கேள்வி எண் கோப்புப் பெயராக கொடுத்து 
சேமிக்கவும்.



6

11.  Home இல் _  Exam documents இல் .SocialMedia ott என்ற கோப்பில் 
சமூக ஊடகங்கள் பற்றிய கட்டுரை கொடுக்கப்பட்டுள்ளது. இந்தக் 
கோப்பை லிப்ரே ஆபீஸ் ரைட்டரில் திறந்து, முக்கிய தலைப்புக்கு (  The

   :  -   ) Power of Social Media A Double Edged Sword  1Heading  என்ற ஸ்டைல் 
கொடுக்கவும்.

துணை தலைப்புகளுக்கு  2Heading  என்ற ஸ்டைலைக் கொடுக்கவும்.
(துணை தலைப்புகள் பச்சை நிறத்தில் கொடுக்கப்பட்டுள்ளது)

பிறகு,  2Heading  என்ற ஸ்டைலில் பின்வரும் மாற்றங்களைச் செய்யவும்.
 Font Family :   URW Bookman L

 Font Size : 110 %
 Font Color : Blue

  Shadow effect

மாற்றியமைக்கப்பட்ட கோப்பை  Home இல் 10 Exam கோப்புதொகுப்பில் 
உங்கள் பதிவு எண்_கேள்வி எண் கோப்புப் பெயராக கொடுத்து 
சேமிக்கவும்.

12.  Home இல் _  Exam documents கோப்புதொகுப்பில் 
_ _ .  Technology in Education ott கோப்பில் ஒரு கட்டுரை 

கொடுக்கப்பட்டுள்ளது. இந்தக் கோப்பை லிப்ரே ஆபீஸ் ரைட்டரில் 
திறந்து,      Table of Contents and Index நுட்பத்தைப் பயன்படுத்தி 
கட்டுரையில் உள்ளடக்க அட்டவணை தயார் செய்யவும். 
•  கட்டுரையின் முதல் பக்கத்தில் உள்ளடக்க அட்டவணை 

சேர்க்கப்பட வேண்டும். 
குறிப்பு:
• அனைத்து துணைத்தலைப்புகளுக்கும் பொருத்தமான Style யை 

கொடுக்கவும். (துணை தலைப்புகள் ஊதா நிறத்தில் உள்ளது)

மாற்றியமைக்கப்பட்ட கோப்பை  Home இல் 10 Exam கோப்புதொகுப்பில் 
உங்கள் பதிவு எண்_கேள்வி எண் கோப்புப் பெயராக கொடுத்து 
சேமிக்கவும்.
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13.  Home இல் _  Exam documents இல் .AI ott கோப்பில் செயற்கை 
நுண்ணறிவு ( ) AI பற்றிய கட்டுரை வழங்கப்படுகிறது. இந்தக் கோப்பை 
லிப்ரே ஆபீஸ் ரைட்டரில் திறந்து,     Table of Contents and Index 
நுட்பத்தைப் பயன்படுத்தி கட்டுரையில் உள்ளடக்க அட்டவணையைச் 
செருகவும். கட்டுரையின் முதல் பக்கத்தில் உள்ளடக்க அட்டவணை 
சேர்க்கப்பட வேண்டும்.

குறிப்பு:

• முக்கிய தலைப்புகளுக்கு  1Heading  என்ற  Style யைக் 
கொடுக்கவும். (முக்கிய தலைப்புகள் சிவப்பு நிறத்தில் 
உள்ளன)

• துணைத் தலைப்புகளுக்கு,  2Heading  என்ற  Style

கொடுக்கவும். (துணைத் தலைப்புகள் பச்சை நிறத்தில் 
கொடுக்கப்பட்டுள்ளது)

மாற்றியமைக்கப்பட்ட கோப்பை  Home இல் 10 Exam கோப்புதொகுப்பில் 
உங்கள் பதிவு எண்_கேள்வி எண் கோப்புப் பெயராக கொடுத்து 
சேமிக்கவும்.

14. ஒரு பள்ளியில்  NSS பிரிவுக்கு தேர்ந்தெடுக்கப்பட்ட மாணவர்களின் 
விவரங்கள்   Home இல் _  Exam documents இல் _ .Nss Volunteer ods கோப்பில் 
கொடுக்கப்பட்டுள்ளது. லிப்ரே ஆபீஸ் ரைட்டரில் மெயில் மெர்ஜ் 
நுட்பத்தைப் பயன்படுத்தி மாணவர்களுக்கான அடையாள 
அட்டைகளை உருவாக்கவும். அடையாள அட்டையின் மாதிரியானது

 Home இல் _  Exam documents இல் _ .  Card Nss ott கோப்பில் 
கொடுக்கப்பட்டுள்ளது.

தயாரிக்கப்பட்ட ஆவணங்களை ஒற்றைக் கோப்பாக  (  )   Single File Home

இல் 10 Exam கோப்புதொகுப்பில் உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு 
பெயராக கொடுத்து சேவ் செய்யவும்.
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15. லிப்ரே ஆபீஸ் ரைட்டரில் உள்ள மெயில் மெர்ஜ் நுட்பம் பயன்படுத்தி,
பள்ளியின் நாடகக் கழகம் நடத்தும் நாடக விழாவிற்கு பெற்றோரை 
அழைக்க அழைப்புக் கடிதங்களைத் தயாரிக்கவும்.  Home இல் 

_  Exam documents கோப்புதொகுப்பில் _ .Parents Details ods என்ற கோப்பில் 
மாதிரி அழைப்புக் கடிதமும், .Drama ott கோப்பில் பெற்றோரின் 
விபரங்களும் கொடுக்கப்பட்டுள்ளது.

தயாரிக்கப்பட்ட அழைப்பு கடிதங்களை ஒற்றைக் கோப்பாக  (  ) Single File

  Home இல் 10 Exam கோப்புதொகுப்பில் உங்கள் பதிவுஎண்_கேள்வி எண் 
கோப்பு பெயராக கொடுத்து சேவ் செய்யவும்.

16. ஒரு பைத்தன் புரோகிராமும் அது செயல்படும் போது கிடைக்கும் வெளியீடும் 
(வெளியீடு1) கொடுக்கப்பட்டுள்ளது.

புரோகிராம் வெளியீடு 1 வெளியீடு 2

புரோகிராமை டைப் செய்து செயல்படுத்திய பிறகு இதே புரோகிராமில் மாற்றம் 
செய்து,  இரண்டாவது வெளியீடு (வெளியீடு 2)  பெறுவதற்காக புரோகிராமை  
மாற்றியமைக்கவும்.  பிறகு  இந்த  கோப்பை,  Home இல்  10Exam  என்ற  
கோப்புத்தொகுப்பில்  உங்கள்  பதிவுஎண்_கேள்வி  எண்  கோப்பு  பெயராக  
கொடுத்து சேமிக்கவும்.
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17. ஒரு பைத்தன் புரோகிராமும் அது செயல்படும் போது கிடைக்கும் வெளியீடும் 

(வெளியீடு1) கொடுக்கப்பட்டுள்ளது.

புரோகிராம் வெளியீடு 1 வெளியீடு 2

புரோகிராமை டைப் செய்து செயல்படுத்திய பிறகு இதே புரோகிராமில் மாற்றம் 
செய்து,  இரண்டாவது வெளியீடு (வெளியீடு 2)  பெறுவதற்காக புரோகிராமை  
மாற்றியமைக்கவும்.  பிறகு  இந்த  கோப்பை,  Home இல்  10Exam  என்ற  
கோப்புத்தொகுப்பில்  உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு  பெயராக  
கொடுத்து சேமிக்கவும்.

18. ஒரு பைத்தன் புரோகிராமும் அது செயல்படும் போது கிடைக்கும் வெளியீடும் 

(வெளியீடு1) கொடுக்கப்பட்டுள்ளது.

புரோகிராம் வெளியீடு 1 வெளியீடு 2

புரோகிராமை டைப் செய்து செயல்படுத்திய பிறகு இதே புரோகிராமில் மாற்றம் 
செய்து,  இரண்டாவது வெளியீடு (வெளியீடு 2)  பெறுவதற்காக புரோகிராமை  
மாற்றியமைக்கவும்.  பிறகு  இந்த  கோப்பை,  Home இல் 10  Exam என்ற  
கோப்புத்தொகுப்பில்  உங்கள் பதிவுஎண்_கேள்வி  எண்  கோப்பு  பெயராக  
கொடுத்து சேமிக்கவும். 
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19. ஒரு பள்ளியில் உள்ள பல்வேறு கிளப் உறுப்பினர்கள் பற்றிய 
தகவல்  Home இல் _  Exam documents இல் .Clubs odb என்ற கோப்பில் 
கொடுக்கப் பட்டுள்ளது. இதில் Members என்ற டேபிளிலிருந்து  SPC

பிரிவில் உள்ள மாணவர்களின் விவரங்கள் கிடைக்க   LibreOffice Base யில்
 Queries நுட்பத்தைப் பயன்படுத்தி தயார் செய்யவும்.

குறிப்பு:-
• குவரி தயார் செய்ய  Queries இல்     UseWizard to Create Query என்ற 

நுட்பத்தை பயன்படுத்தவும்.  Wizard இல்    Field selection லுள்ள 
Tables லிருந்து  :Table Members தேர்ந்தெடுக்கவும்.

• சேர்க்கப்பட வேண்டிய தகவல்கள் ( ) : fields  AdNo, Name, Club.
•   : Search Condition .     Members Club is equal to SPC

மாற்றியமைக்கப்பட்ட கோப்பை (    File → Save As என்ற முறையில்)  
உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து Home இல் 

10Exam  கோப்புதொகுப்பில் சேமிக்கவும். 

20.  Home இல் _  Exam documents இல் .  Score odb என்ற கோப்பில் ஒரு 
வகுப்பின் மாணவர்கள் பல்வேறு பாடங்களில் பெற்ற மதிப்பெண் 
தகவல்களைக் கொடுக்கப்பட்டுள்ளது. இதிலிருந்து,   LibreOffice Base இல் 
Reports நுட்பம் பயன்படுத்தி கீழே கொடுக்கப்பட்டுள்ள 
வழிமுறைகளின்படி கணிதத்தில் 35-க்கு மேல் மதிப்பெண் பெற்ற 
மாணவர்களின் ஒரு ரிப்போர்டை தயாரிக்கவும்.

• ரிப்போர்ட் தயார் செய்ய டேட்டா பேஸ் கோப்பில் 
கொடுக்கப்பட்டுள்ள  : Query _Mathematics Mark என்ற குவரி 
பயன்படுத்தவும். (   Report Wizard இல்   Field selection இல் உள்ள  Tables or 

 queriesலிருந்து :Query _  Mathematics Mark என்ற குவரி 
தேர்ந்தெடுக்கவும்.
• ரிப்போர்டில்  , , Class No Name Mathematics என்ற பில்டுகளைச் 
சேர்க்கவும்.
இந்த அறிக்கையை (    File → Save As என்ற முறையில்) உங்கள் 
பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து Home இல் 10Exam  
கோப்புதொகுப்பில் சேமிக்கவும்



11

21. கீழே கொடுக்கப்பட்டுள்ள வழிமுறைகளின்படி,   Home இல் 
_  Exam documents இல் .  car sifz என்ற கோப்பை   Synfig Studio

மென்பொருளில் திறந்து, நகரும் கார் அனிமேஷனை உருவாக்கவும்.
• காரின் படத்திற்கு, Home இல்  10Images   கோப்புதொகுப்பில் 

.car png படத்தைப் பயன்படுத்தவும்.
• காரின் அளவைக் குறைத்து, 

கேன்வாஸின் இடது பக்கமாக 
ஒழுங்கமைக்கவும்.

• பின்னர், கார் முன்னோக்கி நகரும்  
வகையில் அனிமேஷன் கொடுத்து

இயக்கவும்.
இந்த அனிமேஷனை  flv வடிவில்  Render செய்து, உங்கள் பதிவு 
எண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து  Home இல் 10 Exam என்ற 
கோப்பு தொகுப்பில் சேமிக்கவும்.

22. கடலில் பயணிக்கும் படகின் அனிமேஷன்   Synfig Studio

மென்பொருளில் தயார் செய்யவும். 

குறிப்பு:  
Home ல் 10Images  கோப்புத் தொகுப்பில் உள்ள . , .  sea png boat png என்ற 
படங்களைச் சேர்க்கவும்.

தயாரிக்கப்பட்ட அனிமேஷன் Home ல் 10Exam  கோப்புத் தொகுப்பில் உங்கள் 
பதிவு எண்_கேள்வி எண்ணைக்  கோப்புப் பெயராகச்  சேமிக்கவும்.
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23. Home ல் _Exam documents ல் வழங்கப்பட்டுள்ள .star sifz என்ற 
கோப்பை   Synfig Studio மென்பொருளில் திறந்து கொடுக்கப்பட்ட 
குறிப்புகளின் அடிப்படையில் அனிமேஷன் தயார் செய்யவும். 
குறிப்பு:
• நட்சத்திரத்தின் படத்தை வரைந்து 

சேர்க்கவும்.
• இந்த படம் ‘0’ பிரேமில் இப்பொழுது
உள்ள அளவும் 120 வது பிரேமில்
இதன் இரட்டை அளவும் காணும்
விதத்தில் அனிமேஷன் தயாரிக்கவும்.
தயார் செய்த அனிமேஷனை Home இல் 10Exam  என்ற கோப்பு 
தொகுப்பில் உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து 
சேவ் செய்யவும். இந்தக் கோப்பை  flv பார்மேட்டில்  Render செய்து 
சேமிக்கவும்.

24.   Kerala Tourism என்ற தலைப்பில்
தயாரிக்கப்பட்ட இணையபக்கம்  Home

இல் _  Exam documents

கோப்புதொகுப்பில் 
_ .kerala tourism html என்ற பெயரில்

கொடுக்கப்பட்டுள்ளது. கீழே
கொடுக்கப்பட்டுள்ள செய்முறையைப்
பயன்படுத்தி இந்த இணையப்
பக்கத்தை கவர்ச்சிகரமானதாக்கவும்.

• டெக்ஸ்ட் எடிட்டரில் _kerala tourism.html என்ற கோப்பைத் திறக்கவும்.
• இணையபக்கத்தின் முக்கிய தலைப்புக்கு (  )  : , Kerala Tourism color white

:  background gray என்பன கொடுக்கவும்.
• துணைத் தலைப்புக்கு  red நிறம் கொடுக்கவும்.
• இணையபக்கத்தின்   :  background color yellow கொடுக்கவும்.

மாற்றியமைக்கப்பட்ட .  index html கோப்பை,   Save As முறையைப் பயன்படுத்தி, 
உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து  Home இல் 10 Exam

கோப்புதொகுப்பில்  சேமிக்கவும். பின்னர் இந்த கோப்பை பிரவுசரில் திறந்து 
காட்சிப்படுத்தவும்.
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25. செயற்கை நுண்ணறிவு தொடர்பான
இணையப் பக்கம்  Home இல் _  Exam documents

இல் AI கோப்புதொகுப்பில் .index html என்ற
பெயரில் கொடுக்கப்பட்டுள்ளது. இதை
டெக்ஸ்ட் எடிட்டரில் திறந்து எக்ஸ்டெர்னல்
ஸ்டைல் ஷீட் உட்படுத்தி, மாதிரியில்
உள்ளது போல்  இணையப் பக்கத்தை
கவர்ச்சிகரமானதாக்கவும்.

• _  Exam documents இல் AI என்ற கோப்புதொகுப்பில் கொடுக்கப்பட்டுள்ள 
.  ai cssஎன்ற கோப்பு இணையப்பக்கத்துடன்  link செய்து செயல்பாட்டை 

செய்யவும்.

• செயல்பாட்டை செய்வதற்கு முன் .ai css கோப்பை  Home இல் 10 Exam க்கு 
நகலெடுக்கவும்.

மாற்றியமைக்கப்பட்ட .  index html கோப்பை,   Save As முறையைப் பயன்படுத்தி, 
உங்கள் பதிவுஎண்_கேள்வி எண் கோப்பு பெயராக கொடுத்து  Home இல் 10 Exam

கோப்புதொகுப்பில்  சேமிக்கவும். பின்னர் இந்த கோப்பை பிரவுசரில் திறந்து 
காட்சிப்படுத்தவும்.


